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Service Pack Release Notes Summary: Centricity™ Practice Solution (CPS) 12.X

Key Updates:

e Track & Report Clinical Quality Data for CMS Programs Using Clinical Quality Reporting (CQR)
Sign Up by Sending Us a Request to Join

e Migrating & Managing Immunization Data from Observation Terms to New Immunization Tables
for Quality Reporting and Immunization Interfaces Email Us for Help

e Introduction of CCC Basic: An optional complementary forms package provided by GE to assist
in clinical data capture and quality reporting

New Customer Online Communities:

e Launch of ICD-10 Community
e Launch of CMS Quality Reporting Community
e Launch of Electronic Medication Prior Authorization Community

Service Pack Release Summary*

*Releases are cumulative so that all prior content is carried forward to the next release or service pack

Release Highlights

Service Pack 3 Fixes

Service Pack 4 Fixes

Service Pack 5 Fixes

Service Pack 6 Fixes

Service Pack 7 Fixes, Added CQM Support & SOP Data Capture

Service Pack 8 Fixes, Prescribing Workflow Updates

Service Pack 9 Fixes

Service Pack 10 Fixes, ICD-10 Features & JBoss Installation Tool

Service Pack 11 Fixes, Portal Data Masking & TOC Updates

Service Pack 12 Fixes, Data Mapping Update & Active Reports to activate or inactive
codes

Service Pack 13 Fixes, Key CMS Regulatory Updates for ONC 2014

Practice Management Only Highlights

Please note that all references in this document to “billable” and “non-billable” regarding ICD-10 codes
simply mean “valid” and “invalid” codes. Appropriate code selection is the responsibility of the user.
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Service Pack 3
Chart

e On the Immunization Management HTML form, the Preload function now stores the data to
history. SPR 57803
e  Onthe Immunization Management HTML form, the blue question mark can now be used
multiple times inside the form. SPR 58146
e Care Alert warning messages now display on top of other windows so the user must
acknowledge it before continuing. SPR 58320
e Invalid email addresses no longer cause CCDA validation errors. SPR 58673
e |nvalid characters are now removed during CCDA document generation. Previously, invalid
characters were being included, causing NIST validation to fail. SPR 58704
e Fixed an issue where Immunization data converted from OBS data would contain units that
caused the CCDA to fail validation. SPR 58706
e CCDA generation no longer fails if there is not a responsible provider. SPR 58711
e Clinical Visit Summary prints all problems, medications, and allergies, but only items from the
current visit for other entries. Previously, all previous visits were included for all categories. SPR
58774
e |f a new Immunization or Med Admin custom list has been created by copying a factory custom
list and editing it, there is a risk of it being broken when installing a quarterly Full
Knowledgebase update. To prevent data loss, prior to installing the next Full Knowledgebase
update, for each Immunization and Med Admin custom list:
1. Open the Custom List editor in CPS Admin.
2. Make a new copy of the custom list and give it a new name.
3. Remove the old custom list.
4. Rename the new custom list to the original name.

SPR 58783

e lLanguage codes are now correct in the CCDA. SPR 58787

e Immunizations with NDC codes that contain hyphens now migrate correctly. SPR 58789

e Dosage and units are now migrated correctly when they are entered as a single value with one
Observation Term. SPR 58790

Technical

e JBoss completes processing a CEM job for patient charts with certain observation values that
previously got stuck being processed. SPR 58712

e The FixGrouplD script now runs successfully if there are documents “Filed in Error”. SPR 58715

e CCDA no longer fails validation if the observation unit is empty. SPR 58781

e CCDA generation no longer fails if observations have no value. SPR 58788

e The CQM Query to load events on a new system no longer times out when processing a large
number of charts. SPR 58792
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The Functional Measure query generates successfully when processing a long date range. SPR
58794

Changes made in the Select Printers window are now remembered correctly. SPR 58816

The Immunization Management form no longer gives a script error when loading the form in
charts that contain migrated immunization data. SPR 58848

Copying factory lists in the Custom List Editor now correctly sets the owner to “C” for custom.
SPR 58856

The MU Checklist form now correctly records height and BMI for a visit if the values are the
same as previously. SPR 58863

ICD-9 codes now convert to ICD-10 codes correctly when updating from previous versions of
CPS. Previously, some codes were showing as SNOMED codes. SPR 58868

The Immunization Migration tool now migrates items with invalid VIS or NDC codes. When an
invalid VIS or NDC is encountered during migration, they are listed as “null” and the original is
appended to the Admin Comment. SPR 58936

When the Immunization Management tool encounters entries with invalid VIS or NDC codes it
now migrates them and sets the values to NULL and appends the original to the Admin
comment. Previously, the tool flagged these as invalid and did not migrate them. SPR 58939
When the Service Layer is configured to “Disable Interfaces” the service layer now loads
properly. SPR 58945

eRx renewal requests now match items on the active medication list based on GPI, reducing the
risk of mismatches. SPR 58947

Do not use Stop Date on custom forms using the immun_add, immun_update, and
immun_getlist data symbols. Immunizations created with a stop date are not exported in the
CCDA and are not counted for CQMs. SPR 59013

Print handouts now increment the numerator for option (ii) of MU Stage 2 patient education
with handouts. SPR 59018

Language codes that contain invalid or non-standard entries are now listed as “unknown” when
generating a CCDA. SPR 59043

During CCDA validation, if anything other than the five valid race codes are used, the Primary
race code is set to “unknown” and the entry in the patient record is added as a secondary race
code. SPR 59046

Lab results with line breaks no longer cause a CCDA validation failure. SPR 59049

The “doseQuantity” value in the CCDA no longer contains extraneous decimal units. SPR 59052
Medication precondition codes with spaces no longer cause a CCDA validation failure. SPR
59056

Fixed an issue where LinkLogic created documents when importing appointment messages
when it was configured not to. SPR 53957

The Immunization Management HTML form no longer gives errors if the CVX code is empty. SPR
59087

Added details for counting ePrescribing events towards measures to the Meaningful Use Guide.
SPR 59147

Generated CCDA documents are now validated before exporting to CQR. SPR 59187
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Stop times can now be entered for Functional Measure subscriptions. SPR 59193

The FH-SH-CCC form no longer translates inactive records into the chart note. SPR 59195

Line breaks are now removed from lab results, preventing CCDA validation errors. SPR 59199

Race subcategories are now included in CCDA calculations. SPR 59204

Invalid characters no longer appear in the CCDA, causing validation failures. SPR 59208

Invalid document types no longer cause CCDA failures. SPR 59211

Revised information in several workflows in the Meaningful Use guide. SPR 59220

Modified the signature of the ADD_MUACTIVITY_LOG() method to make it easier to use and

more relevant for form developers. SPR 59254

Problem search in custom lists and quick search now includes results where the term is

contained as a word anywhere in the description as long as it is a word by itself and not a suffix.

For example, a search for “pain” will return results for head pain, stomach pain, hip pain, etc. It

will not return results where “pain” is not a separate word such as “hippain”. SPR 59266

On the Review Electronic Prescriptions screen, the Authorizing Provider changes to the logged in

user and the prescription cannot be sent.
Resolution: A signing provider with the Access Electronic Prescribing privilege can
create, sign, and send an electronic prescription authorized by another provider. As long
as the signing provider is not the Responsible Provider for the document, when they
sign the prescription they are listed on the Review screen as Prescribing Agent along
with the Authorizing Provider. However, a Prescribing Agent cannot electronically
prescribe medications for more than one authorizing provider in a single update. You
must change the medications to a single authorizing provider or create separate
updates for each authorizing provider. As part of this design change there is a slight
change to the workflow for Prescribing Agents (such as Medical Assistants) to review
and approve electronic prescription refill requests. Now, when an update is signed, the
user is prompted whether to become the Responsible Provider for the update. A
Prescribing Agent should click No. The Review Electronic Prescriptions screen now
includes both the Authorizing Provider and the Prescribing Agent. SPR 58817

See Service Pack 3 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-63697
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Service Pack 4

e Race information for “White” and “Native Hawaiian or Other Pacific Islander” were being
removed from the database when upgrading to Centricity Practice Solution 12. SPR 60190

e Upgrading to Centricity Practice Solution 12 was causing Foreign Key constraint errors. SPR
60212

e The application crashes with the error message “Error occurred in class , method
CChartSummaryTabView::onUIRefresh”. SPR 60202

e Combo vaccines that had some of the series entered prior to installing the Immunization
Management HTML form now track the correct series number. SPR 60203

e Users are seeing too many drug contraindication results, specifically drugproblem, drug-age and
drug-gender contraindications. These displays make it more difficult to see truly critical health
alerts and causes alert fatigue. To reduce the number of contraindications, users can optionally
exclude three less critical drug contraindication types in the JMX console under JBoss. This
configuration option will be available in the application user interface in the forthcoming
release. See “Use JBoss JIMX Console” on page 15. SPR 60204

e Some customers have experienced a failure when the QIE interface engine pulls data from
Centricity Practice Solution to send to the CQR server. When this occurs, the WebService
requests made by the QIE server get locked up in requests to the ActiveMQ queuing system,
which causes QIE to timeout and retry the request. These requests pile up and use all the
threads available in the JBoss server, making the server unable to respond. SPR 60208 This patch
includes a change to update to a newer version of Active MQ which addresses these issues.

See Service Pack 4 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-71719
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Service Pack 5

e Combo vaccine series are now calculated for the Immunization History View and Immunization
Letter consistent with the Immunization Management form. SPR 59929

e The installer no longer fails with the error “Foreign Key Constraint ‘FK_PatientRace_PID’”. SPR
60034

e Opening multiple list views no longer causes application crashes due to “out of memory” errors.
SPR 60331

e The Clinical Visit Summary now prints only information from the current visit except for
problems, medications, and allergies. Previously, all previous visits were included for all
categories. SPR 60383

e Fixed an issue where CPT codes were being incorrectly identified as SNOMED in the CCDA. SPR
60385

e The client installer now correctly places registry values in the correct registry for 64-bit
operating systems. SPR 60459

e Fixed an issue where payment entry gave an error and caused an application crash. SPR 60446

e Applying the July Knowledgebase update after applying the June ICD and CPT codes no longer
causes the Knowledgebase update to fail. SPR 60349

See Service Pack 5 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-79371
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Service Pack 6

e Changed the behavior of the GET_MUActivity _Log data symbol so that printing must always
finish before the log is retrieved. SPR 58925

e Immunization Migration tool now creates a required index that prevents slowness previously
experienced by some customers without timing out. The tool creates an index on the OBS table
required for faster performance. Previously, the index had to be created manually on
OBS.OBSID. SPR 59296,SPR 59458

e Vaccine groups on the Immunization Management form now appear on the text translation. SPR
60127

e All vaccines entered on the Immunization Management form now appear on the document
view. SPR 60141

e CVS documents now inherit the confidentiality settings of the parent document. SPR 60165

e The Location of Care for a document is retrieved from the associated location. SPR 60220

e Various stability fixes. SPR 60217, SPR 60263, SPR 60552, SPR 60598

e TOC documents now inherit the confidentiality settings of the parent document. SPR 60435

e Fixed an issue where an instance of a patient visit is open at the same time an instance of a
patient billing is also open would generate a system error when the visit is saved. SPR 60525,
SPR 60609

e Registries created in LinkLogic now show on the Registry tab. SPR 60562

e Uninstalling a CPS website on a JBoss server with multiple CPS websites no longer causes a crash
when searching for problems in Chart. SPR 60567

e When generating a statement for a patient who has a balance under two companies,
statements are generated for both companies. SPR 60568

e Significantly improved performance is expected with a change to the tool design that eliminates
the need for the DM_MIGRATION_OBS_MIGRATED table to back up migrated rows from the
OBS table. Previously tool performance was degraded and consumed more I/O resources than
necessary, especially when running with parallel threads. SPR 60569

e [f a patient chart is open and has no updates in progress, users can now print documents from
the desktop. SPR 60578

e Only active medications are displayed in the update medications dialog. Removing a medication
no longer causes a duplicate listing. SPR 60587

e After using the Medication Administration form the Medications tab no longer includes
duplicates. SPR 60590

e Uncoded medications are no longer counted for CPOE measure calculations. SPR 60601

e Fixed an issue where multiple instances of the same patient visit would crash the application
when the visit is saved. SPR 60608

e The Immunization Migration Wizard now correctly ignores time information in the adverse
reaction field. SPR 60620

e Now able to generate an on Demand Statement for an account that has a credit balance. SPR
60637

e Fixed an issue where a resource does not get released properly, and causes a resource leak. SPR
60640
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All vaccines entered on the Immunization Management form now appear on the text of the
chart document. SPR 60658

The Data Migration tool now migrates “pneuped (Prevnar unspecified)” to CVX- 152. SPR 60666
Fixed an issue where an order number is not being generated for every order. SPR 60673

On the Immunization Management form, administering Proquad now indicates that Varicella,
Measles, Mumps, and Rubella have been administered. SPR 60676

The Immunization Management history view now lists Measles, Mumps, and Rubella individually
when an MMR is given. SPR 60681

The Immunization Management form now produces a text translation in the chart note. SPR
60682

Growth chart data point tool-tip popup now shows correctly in Internet Explorer 10. SPR 60707
Fixed an issue where CCDAs generated allow invalid values for ethnicity codes. SPR 60713

Fixed an issue where Immunization Migration Wizard generates undetermined vaccines. SPR
60727

Changes to the Common Event Model default parameters for stability and performance
enhancements. SPR 60733

Common Event Model configuration parameters are now editable in the JMX console. SPR
60734

The Immunization Migration tool now evaluates additional values in determining whether an
immunization Was Given. A separate post-processing SQL script is available to clean up
Undetermined vaccines if you already migrated data. The script can also be customized to look
for values unique to your site. SPR 60740

Enhanced Administered Date calculation. The tool first checks to see if a valid 'AD' value exists. If
so, that date is used. If not, it parses the main observation value for a date, and uses that if
found. Otherwise, it uses the obsdate of the main observation. SPR 60743

Fixed an issue where vaccines for Reason Not Given or Adverse Reactions are not migrating. SPR
60744

Fixed an issue where clicking Rx Refill would hang and crash the application. SPR 60845
Redesigned CVS layout so that it is easier to read. The header (patient information) is clearly
separated from the rest of the CVS sections and content. SPR 60962, SPR 60964

CVS preview now matches CVS printout. SPR 60965

See Service Pack 6 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-81641
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Service Pack 7

Features
e Added support for 14 Clinical Quality Measures (CQMs)
e Added ability to associate a source of payment (SOP) code for PQRS submission in CQR

Fixes

e EPID has been added to the CCDA generated for CQR. SPR 61185

e Fixed an issue where, on the CCDA, prescribed medications were listed as “ordered” instead
“active”. SPR 61205/59103

e The start/stop dates of medication orders on the CCDA are taken from the prescribing/refill time
rather than from the medication duration date. SPR 61207/ 59173

e Insurance carries now load correctly when using System > Load Insurance Carrier > Search. SPR
61259/61255

e The CCDA now includes the Risk Category Assessment category in the Procedure subsection of
the Results section. SPR 61317/59226

e Onthe CCCDA, the Procedure and Performed stop and start dates for GE Negated Observations
are now the same. SPR 61318/59954

e Fixes an issue where a CVS created for one patient was attached to a document on a different
patient. SPR 61800/60572

e The FH-SH-CCC form no records “No Known Relative” and “No Known Family History” as a first
degree relative to allow for adopted patients to get credit for MU Family History measures. SPR
61858

e Fixed an issue where the Care Provider on the CVS was listed as the user who created the
document rather than the provider of the document. SPR 61649

e Performance & Reliability Updates

e Modification to the nightly job sending data to CQR

e Core and Menu measures updates for Meaningful Use Reporting

See Service Pack 7 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-103076
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Service Pack 8

Features

Fixes

A route can now be selected when defining the medication to be prescribed. By default, the
route information from Medispan is automatically entered, but an alternative route may be
selected from the drop-down. If route information is not available from Medispan, this field is
blank and can be manually selected. For existing medications, the route information is blank.
Users may update the route information in the Change Medication window. The updated route
will not appear in MEL symbols or CCDA documents. SPR 62121

A new audit report has been added that retrieves the list of prescribed medications for a specific
date range and user. SPR 62347

The Electronic Prescriptions settings have been updated to allow for more granularity when
specifying methods for sending prescriptions via fax or electronically. Previously,
enabling/disabling electronic prescribing and direct faxing of prescriptions to a pharmacy were
combined. To better support practices in States that allow electronic prescribing, but disallow
direct faxing of prescriptions, these selections have been separated. Please consult your State
law and configure appropriately. Access the settings via Administration > Charts > Electronic
Prescriptions. SPR 62080

Fixed meaningful use calculations for the NQF 0028 and CPOE Qualification reports. SPR 48663,
SPR 48670

Problems that were Filed in Error no longer appear on the Clinical Visit Summary or CCDA. SPR
61225/61201

Redesigned CVS layout so that it is easier to read. The header (patient information) is clearly
separated from the rest of the CVS sections and content. SPR 61416/ 61181

Generic or uncoded medications that were administered now appear on the CVS and TOC. SPR
61418/61242

Only Immunizations administered during the current visit are included on the CVS and TOC. SPR
61420/61338

Fixed an issue with CCDA import validation, but does not address validation issues with
reconciliation of medications, problems, allergies, or procedures. SPR 61810/ 59244

The electronic and print versions of the CVS now contain the same sections. SPR 61886/61828
Performance enhancements to DTS processing. SPR 61527/61937

Fixed an issue where LinkLogic would occasionally import insurance information in the reversed
order of precedence. SPR 62178/60754

Fixed an issue where the Care Provider on the CVS was listed as the user who created the
document rather than the responsible provider of the document. SPR 62179/61649

When there are items on the CVS that are too long for the page, the text now wraps
appropriately and the text size no longer shrinks. SPR 62476

On the CPOE A&P-CCC form, the capacity of the drop-down field for problems has been
approximately doubled. The total number of problems contained in the list is limited to about
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80, depending on the length of the description and ICD codes included. SPR 62209/59444, SPR
62282

e On the Medication Administration HTML form, the NDC for the selected medication can now be
selected from a drop-down if multiple NDC codes have been configured. The selected NDC code
is also added to the comment field. SPR 62211/60102

e Changes to the Immunization Management HTML form:

o The NDC for the selected vaccine now displays on the Administer window. The field is
not editable in this window and must be configured using the Immunization Custom List
Editor. SPR 57657/62280

o Entering an immunization on the form and selecting to auto-generate orders now
correctly creates an Administration Order. SPR 62283/60022

e  On the Immunization Management form, the Administered Date can now be the patient’s DOB.
Previously, an error was given that the Administered Date could not be earlier than the DOB.
SPR 62318/59793

e The 'Adverse Reaction' button has been removed from the 'Administer ' window. An adverse
reaction cannot be recorded until the immunization record has been committed.

e The 'Details ' dialog (opened by clicking the green check icon), for an immunization with an
adverse reaction already noted, now has two buttons; 'View Adv Reaction' and 'Edit Adv
Reaction'.

e Use the 'View Adv Reaction' button to open the 'Adverse Reaction for ' window.

e Use the 'Edit Adv Reaction' button to open the 'Update Adverse Reaction' window.

e The 'Adverse Reaction for ' dialog now includes an 'Edit' button. Use this button to open the
'Update Adverse Reaction for ' dialog. SPR 62215/61441

e Lot Numbers may be entered in two ways: using Manage Lots to maintain lists of lot numbers
with expiration dates, or free text entry of lot numbers. Lot numbers entered as free text are
not 'remembered' for future selection.

o A checkbox enables use of Manage Lots. The checkbox remembers each user's last selection.

e If Checked, the 'LM' (Lot Management) button is enabled and the Lot number field is a drop-
down list of defined lots. As before, selection of a lot number includes the expiration date. Click
'LM' to open the 'Lot Management for dialog.

o If unchecked. The 'LM' button is disabled. The lot number can be entered as free text in the Lot
# field. The expiration date is entered as before. SPR 62213/61532

e When Lot Management is used, lots will eventually expire. Now, these lots (numbers and
associated expiration dates) will be automatically removed from the lot number list. Scanning
for expired lots will occur with the opening of any immunization custom list for the first time for
the day by any user. SPR 62212/61531

e There are two places where historical immunization records can be entered. Previously, for
Preload, the name “Unknown” appeared at the bottom of the drop-down list of users. This no
longer appears. When using the Preload dialog to enter a historical record, the user may leave
“Administered by” blank or they may select a user from the list. You may add a user to your
system (such as “Unknown” or “External Immunization Provider”) as a substitute to indicate the
individual is unknown or from another clinic. SPR 62216/59141

e Fixed an issue where a script error occurred while using the form. SPR 62214/ 61998
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e The Immunization History View and Letter no longer include lines for vaccine groups that were
not given. SPR 58148/62281

e The SP7 release notes included partial information regarding the Clinical Quality Reporting v1.3
update. For complete details, refer to the CQR v1.3 release notes available on the services
portal. SPR 62261

e |norder to export patient data for Clinical Quality Measure reporting, the Clinical Quality
Measures Reporting subscription must be enabled and configured in your interface engine, and
you must also have the Inquiries/Reports > Export Patients permission. SPR 62113

e Fixes for problem search:

Results now include descriptions with special characters. SPR 62434/54197
The quick search function now displays up to 10 results. SPR 62446

The smart search filter now returns results if the keyword(s) phrase is longer than 15
characters. SPR 62435/52881

ICD search now includes full synonym search capability. The next ICD and CPT updates after
January 2015 must be installed. SPR 62455/54247

e Fixed an issue where an appended order created “Seen By” visit with Append and not with parent
document ID. An order added in an append logged a “Seen By” visit with the append document and
did not match with the numerator when the Clinical Visit Summary (CVS) was generated. SPR
62493/62735

This release corrects these contributing causes:

A clinical visit summary attached to an order created within an append and logged as a
“seen by” visit was not correctly associated with the parent visit by CQR and therefore not
counted in the numerator. Appended encounters now always point to the parent document.

If you were using custom document types for functional measures and identified an order
code without a CPT- prefix, these codes were not sent to CQR. We automatically send for
office visit, office procedure and home health visit, but other document types won’t be
counted as Seen By. Now service orders matching orders in the GE Office Visit value set that
have no prefix as well as those with CPT-, SCT-, SNO-, SNOMED-, or CDT- prefixes are sent. If
a code with no prefix is a service order and it is in the value set, it is sent. SPR 62302

e Fixed an issue where patients sometimes appeared in both numerator met and unmet counts for 13
Clinical Visit Summary (Stage 1). When a patient visit was appended using the full append option
and selecting Document Type of Office Visit, the patient was counted twice in the denominator and
only once the numerator even when a Clinical Visit Summary was printed for the original visit
(parent document). If both the original and the appended document are office visits, each document
is counted in the denominator; however, the appended Office Visit is counted as CVS unmet
because the event of providing a Clinical Summary (printing, sending, declining) is only linked to the
parent document. Now the chain of documents is counted as one encounter. SPR 62514/62737

e The application now checks for a valid service provider when generating a TOC. SPR 62872
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See Service Pack 8 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-139118
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Service Pack 9

e Fixed an issue where provider names were not correctly displaying a suffix. SPR 51010

e |nquiries can now be run to find patients based on Race Subcategory and Ethnicity Subcategory.
SPR 62218

e Anend date is no longer required when changing a Test Order. SPR 62535/SPR 58666

e Fixed an issue where the default printer randomly changed. SPR 62575/SPR 61077

e Fixed an issue where removed items on the medication list appeared in the wrong order. SPR
62578/SPR 62174

e Providers no longer get the error “The parameter is incorrect” when trying to sign a document
while a prescription is pending with a prescription method of “Samples Given”. SPR 62618/SPR
60046

e Updated copyright information on the login window. SPR 62619/SPR 58409

e TOC documents can now be created when an order status is “In Process”. A change from
“Admin Hold” to “In Process” status is a trigger for an automated TOC send and can have
implications depending on your workflows:

o This change affects customers using the Orders Module to create Referral Orders that
have a status of “In Process” when signed and are using an automated TOC CCDA
generation process (QIE TOC). A CCDA TOC automatically generates when a Referral
Order is “In Process” and has a service provider with an electronic address. When an
order like this is signed, the TOC generates and sends an un-customized TOC. When a
Referral Coordinator returns to the Referral Order to customize, create, and send a TOC
at a later time, a second TOC is generated and sent to the recipient provider. The
recipient provider can expect to receive two different TOCs, whose difference depends
on the amount of customization, at two different times, depending on the duration
between original signing and TOC/ referral coordination. It does not affect the MANUAL
Surescripts Secure Message workflow.

o This change affects all customers; GE's definition of “In Process” is changed. Previously,
“In Process” meant that all referral coordination was completed, and the order was
sent. Now it means the CCDA can still be generated and modified. This may cause some
confusion to users that are used to how the orders module works.

SPR 61535/SPR 62646

e The Immunization HTML form now records clinical list changes for historical vaccines. SPR
62647/SPR 61973

e Providers no longer get the error “An Authorizing Provider is Missing for Order” when ordering
more than one SPR 62649/SPR 56446

e Improved application stability when a network or server error is encountered. SPR 62694/SPR
61410

e TOC and CVS documents now print fully when it was previously saved in the chart. SPR
62724/SPR 59084

e Signing a received lab result no longer causes the auto-completion of orders to regenerate CCDA
documents. SPR 62747/SPR 62714
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Fixed an issue where an “Undefined” message appeared on certain medications. SPR 62763/SPR
62224

Assessments are now included in the CCDA as structured data. SPR 62774/SPR 62822

CDA GE General Observation section now includes all observation data. SPR 62775/SPR 62825
CCDA documents now include tracer IDs. SPR 62776/SPR 62816

Document types “Clinical Visit Summary”, “History and Physical Note - Imp”, “Progress Note -
Exp” and “Progress Note - Imp” have been removed from the Document Type drop-down list in
the Update Chart dialog. SPR 62793/SPR 58047

Fixed an issue where patients were randomly left off a statement run when batching them from
Reports > File > Statements. SPR 62849/SPR 61659

See Service Pack 9 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-139347
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Service Pack 10
Features for ICD-10

e Problem search - enhanced usability with ICD-10 specificity support. This release provides
enhanced problem content and search capability / usability. It includes enhanced synonym
support for Smart List searching, more accurate and complete mappings, simplified search
workflows, and the ability to identify and quickly select the most specific codes.

e Problem descriptions increased from 27k to 97k in the database for richer code set.

e Search algorithm enhanced to increase precision and accuracy of the search.

e Quick Search Problem Search only displays codes that are specific enough for billing. Specific
codes are defined as Active and with appropriate specificity (no child codes). Once a provider
selects a diagnosis three times, it’s added to their Smart List to speed up searching. Smart Lists
are used in the Quick Search and Full Reference Problem Search features.

e Problem Custom Lists - Codes that are not specific enough for billing purposes do not display in
problem lists You should review custom lists to remove/replace invalid codes with more specific
codes and to assure accuracy in the mapped ICD-10 codes. See “Problem list cleanup” on page 6,
for help identifying problem codes that should be updated.

e Full Reference Search no longer displays the ICD-9 folder “drill down” hierarchy. Instead, the
search displays group level codes and more specific codes depending on the search. Show
Inactive Codes check box is also removed from the search window.

e Full Reference Search always searches both ICD-9 and ICD-10 codes and retrieves codes based
on clinical concept, so it is no longer necessary to choose a code type before searching. SPR
54777

e Group codes or other codes not specific enough for billing display in italic in the results window
and cannot be used. Double-click these codes to drill down to related codes with greater
specificity that can be used.

e Insufficiently specific codes cannot be added to the patient’s problem list. When you select a
code that is not specific enough for billing, the OK button is disabled and a warning displays

e Orders module - ICD-10 specificity indicator. When you select a diagnosis from the Orders
Potential Diagnoses list, a code that is not sufficiently specific for ICD- 10 displays in orange with
an asterisk like this example: * BRONCHITIS and should not be associated with the order. The
system will display a warning but will not prevent you from associating the code with an order.
To see more information associated with the code description, hover over the code to see the
ICD-9 and mapped ICD-10 code. You must select another diagnosis code from the list for the
order, or click Edit and search for a more specific code (see below). This workflow preserves the
history with the previous code.

e Orders module - Edit a diagnosis for an order in the Orders module - To change a diagnosis in
the Potential Diagnoses list, select it and then click Edit. Then search for and change the
diagnosis on the Edit Problem window.

e  With the transition from ICD-9 to ICD-10, it is necessary to review existing active problem lists
for patients because they were originally coded with ICD-9 concepts and more specificity might
be required. Custom problem lists should also be reviewed for accuracy in mapped ICD-10 codes
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or redesigned altogether to accommodate new coding concepts. Existing problems in a patient
chart may have codes that are not sufficiently specific for billing, so you can run Non-Billable
Diagnosis in Patient Records (Crystal) report to identify such problem codes for patients with
past or future appointments and gradually update charts with more specific codes.

e (Cloud-based advanced specificity problem search with clinical attributes options Cloud-based
Advanced Specificity Problem Search is available in limited release to select customers based on
number of users. If this feature is enabled for your organization, when you use the Full
Reference Search in Chart or in Billing and Case Management, you'll access the latest HLI ICD-9
and ICD-10 code database where you can quickly find and select the most specific diagnosis
code for billing. This feature must be enabled by GE Support.

o Enable cloud-based problem search - If enabled for your organization, in Administration,
go to Advanced Features and check Enable Advanced Specificity Problem Search.

o Confirm your firewall permits workstation access to this URL:
https://gel.healthlanguage.com/le-services-342/soap/query

o If your site loses Internet access, return to setup and uncheck this option to switch to
the on-premise version of problem search.

o Search for and select the most specific code using Clinical Attributes - From search
results, select a term to review its level of specificity for ICD-10 billing. Where relevant,
select additional Clinical Attributes for a more specific code, such as disease process,
anatomical site, causative agent, episode of care, laterality, stage, healing, time course,
fracture type, and so on.

e Build and manage Task queues with Diagnoses as a criteria In Task Management > Queue
Administration > Build Queues, the Queue Criteria pane allows users to search for and add one
or more diagnoses to associate with the visit using the Find Diagnosis window. The application
also alerts you when you have entered an invalid code.

e Interoperability — MIK can determine the correct ICD code when duplicate code names exist in
ICD 9 and ICD 10. When problem codes are received from an external system without a coding
system name value, sometimes a unique match cannot be found based on the code value alone
if the code value exists in both ICD9 and ICD10 code databases. When this happens, MIK sends
“???” for the code to the Notes tab and notes that “MIK import found multiple codes matching
the diagnosis ....”. To prevent these unmatched codes, MIK now matches using both the code
value and the code system name. The coding system database to search is set to ICD9 by default
in MIK Destination setup. Important. When your organization implements ICD10, change this
setting to ICD10. SPR 63443

e Other usability enhancements Launch Update Medications, Problems, and Orders windows from
Chart Update viewer. Buttons have been added to the Update Chart window to open Update
Medications, Update Problems, and Update Orders. SPR 63076

e Automated server configuration utility The Server Configurator calculates, installs and deploys
the recommended JBoss and Service Layer configuration for your site. You can add/remove
servers to meet the recommended configuration, validate, and then automatically install JBoss
to support the selected configuration. The Apply Updates, Install JBoss, Install Service Layer,
Install Website, and Change App Logon buttons have been removed from Server Setup. You
must use Server Configurator for these tasks. Server Configurator is launched after you have
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installed or updated your database with Server Setup. The Server Configurator button is located
on the main Server Setup menu. Press F1 after launching Server Configurator to access the
online help. See Release Notes for more details.

Fixes

e Performance and stability enhancements. SPR 61049, SPR 61385, SPR 61797, SPR 61923, SPR
63166, SPR 63333, SPR 63349, SPR 63374, SPR 63412, SPR 63434, SPR 63438, SPR 63441, SPR
63466, SPR 63470, SPR 63474, SPR 63572, SPR 63655, SPR 63816, SPR 63696

e Addresses various login issues. SPR 60959, SPR 60996, SPR 61011, SPR 61026, SPR 61027, SPR
61028, SPR 61044

e Stability improvements during CCDA generation. SPR 56521

e Addresses an issue where the application would crash if the user tabbed out of the Prescribing
Method field in the Refill Medication window. SPR 56999

e Addresses an issue where clicking to go to another form component from the CCC Basic
encounter type opened a different component. SPR 58736

e Addresses an issue where users received a message about incomplete orders on every visit that
had a test order that is not in a status of “Complete”. SPR 61402

e Updates to the Immunization Management HTML form to associate an allergy with an
immunization adverse reaction. Users can now add, update, or remove an allergy (including
criticality) to an immunization. The text translation has also been enhanced to translate
criticality from an associated allergy and displays it in the chart note:

e New data symbols:

o MEL_ADD_ALLERGY_GET_GROUPID — Adds a new allergy or adverse reaction to the
patient's allergy list and returns the reference (allergyGrouplD) for an added allergy.

o MEL_GET_ACTIVE_ALLERGY — Returns the latest active allergy detail associated with a
given allergyGrouplD for a patient.

o MEL_GET_SDID() — Returns the current active document's SDID.

o Updated data symbols:

o IMMUN_ADD, IMMUN_UPDATE, IMMUN_GETLIST — AllergyGroupld added to values
returned for an immunization SPR 61975

e Addresses an issue where the client crashed when putting an update on hold with a required
field not filled in. SPR 62092

e Addresses an issue where entering two medications on the Medication Administration HTML
form resulted in only the first text translation. SPR 62516

e Addresses an issue where bulk retrieving charges procedure codes were randomly duplicated
multiple times for each charge on the visit. SPR 62595

e Addresses an issue where the scrollbar suddenly jumps to the top of the window during a
refresh. SPR 62933

e Diagnosis codes are now saved correctly to the visit. SPR 62977

e Addresses various issues with formatting options in updates and letters not working correctly.
SPR 57724, SPR 63069, SPR 63087

e Addresses an issue where the application crashed if the user clicked the close window (X) button
multiple times. SPR 63164
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Addresses an issue where the application froze when adding problems from the orders window.
SPR 63169

Addresses an issue where CCDA generation caused an error in the Allergy section. SPR 63179
Addresses an issue where, if LinkLogic is configured to create an on-hold document when
appointments arrive, if an arrived appointment is then modified, a second on-hold document is
created through DTS. SPR 63239

Addresses an issue where the Transition of Care box was not staying checked if there were on
hold documents. SPR 63262

Corrects the data symbol ADD_ATTACHMENT() to restore the ability to specify a UNC moniker
path for an image attachment starting with \\. Now a moniker can either be a relative path
name or a UNC (absolute) path name, beginning with \\ or a URL, or something like “E://...”
Backslash in the path names followed by special characters such as \t, \n, \r are also supported
and properly interpreted. For example, “C:\radiology\tumor images\normal_mam.bmp”. See
data symbols help for ADD_ATTACHMENT() for details and examples. SPR 63281

Addresses an issue where the message “Error Occurred in Class, Method Window:: event -
WNMsg = 273" appeared and the application crashed when users opened various CCC Basic and
Orthopedic forms. SPR 63372

Only adjudicated procedures are considered to be included in the residual column once an ERA
payment has been posted. SPR 63383

Adds diagnostic code to analyze the occurrence of “CurrentDomainOnUnhandledException”
errors. SPR 63387

Addresses certain situations that would cause the error “Error occurred in class , method
CMLRouteDocumentDlg::0OnSign”. SPR 63391

Addresses an issue where clicking the New Document button caused the application to crash.
SPR 63419

Addresses an issue where, if a user uses the refill button and the NDC Number has changed due
to a Knowledgebase update, the new prescription failed due to an NDC number mismatch. SPR
63515

Addresses an issue where users were asked to override interactions that were already
overwritten. SPR 63520

The document type is now included in the CCDA. SPR 63524

Addresses an issue where one DTS appeared to be processing another DTS’ messages when
there were multiple DTS instances. SPR 63530

The prescription report for New Jersey now prints one medication per page. An additional
report (prescnj_4up.rpt) is available if the requirement changes to allow multiple medications
on a page. To use this report, rename the original prescnj.rpt file to any other name (for
example, prescnj_1lup.rpt) and rename prescnj_4up.rpt to prescnj.rpt. SPR 63560

Addresses an issue where a patient’s date of birth falls in the current year, on initial load of CQR
Subscription, the CCDA is not generated for that patient. SPR 63598

Addresses an issue where Functional Measure subscriptions were timing out while creating
CCDAs, resulting in inaccurate CQR reports. SPR 63602

Addresses an issue where DDIDs rolled over and were out of order, causing the application to
crash. SPR 63629
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Addresses an issue where refilling a prescription from the chart caused the error “Refill is either
0 or the prescribing method is fax or electronic”. SPR 63211/SPR 63670

Addresses an issue where forms were not opening correctly when double-clicked in the
navigation pane. SPR 63779

Addresses an issue where the application crashed when appending a document with an
embedded image. SPR 63884

Addresses an issue where client crashed when a user closed a form and then logged out and
logged in again as same user. SPR 63895

Corrected issue on the Inquiries windows, where tabbing from the Find section caused client to
crash. SPR 59262, SPR 56999

CCDA now sends authorized by provider instead of signing provider for encounters and
procedures so the patient is included for Clinical Quality Measures reporting. This corrects a
problem where patient was not included in the CQM results even though a SNOMED code was
appended to a qualifying office visit during the reporting period. SPR 63326

Addresses an issue where an encounter form is hidden behind the chart module when a user
logs out of the client during a chart update, and then logs back in as different user with “return
to Chart”. SPR 63904

Title bar for Confidential Encounter type now displays all relevant information instead of being
blank. SPR 58142

Addresses application error that occurs when attempting to approve a visit from the Visit
window. SPR 63924

Fixes an issue where the application crashes while a prescription printing is in progress, when
the user selects a different form from the form list pane. SPR 63851 Issues addressed for GA
release:

Quick and full problem search results that are an exact match for text entered now appear at
the top of the list of returned results. SPR 63967

Corrected some keywords data content for problem search with incorrect associations. SPR
63808

CPOE for Lab & Rad now calculating correctly in CQR if non-licensed staff enters the firstin a
series of orders for the patient. SPR 63686

In the Advanced Specificity Problem Search if a user selects a valid but less specific code with
multiple refinement options, the search now returns the parent code. Previously, it returned the
more specific first code from the refinement list, which could result in an incorrect problem
being added to the patient's chart. SPR 63999

Advanced Specificity Problem Search attribute filtering now functioning properly and returning
all appropriate codes. Previously, clinical concepts that require a circumstance code in addition
to a primary diagnosis could not be refined to select the circumstance code. SPR 64002
Addresses performance and stability issues occurring at sites running more than 3 website/JBoss
deployments. Now on Server Configurator you can choose configuration settings options for 2-4
or 5-8 web site deployments. See “ICD-10 planning and preparation resources on the Service
Portal” on page 10. SPR 63974

Now when opening Chart from Schedule for the very first time, the Chart module is in from of
the schedule and not minimized. SPR 63969
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Now when adding a form in a Full Append Update, the form is no longer occasionally hidden
behind the chart window. SPR 63918

The width of the desktop summary column now remains after it is adjusted. SPR 53561/SPR
58368

Fixes an issue where documents co-signed after the nightly JSON extract were not associated
with the EP unless they were appended. SPR 63961 CCC Basic v1.2 includes the following fixes:
You can now preload PCV7 in Immunization Administration. Vaccine Pneumococcal PCV13 is
renamed to PneumoPCV in the Imm_vaccinegroupname table. SPR 64039

The CPOE A&P-CCC Form now pulls in medications for all diagnosis codes. SPR 61951

The Entry Form editor now opens the correct library file when “Open text file to edit” is clicked.
SPR 63034

Deleting a series in the middle of an immunization custom list no longer causes an error while
loading the Immunization Management form. SPR 63444

Fixed an issue where adding a problem in the CPOE A&P form resulted in an error during order
generation. SPR 63315

Fixed an issue in the Immunization Management form where, if the Amount Given field
contained both a numeric value and a unit dose, the vaccination record would not save. SPR
62141

The Problem- CCC form now correctly returns the mapped Problem Custom List. SPR 62202
Fixed label in the Risk Factors-CCC form to read “Felt guilty about drinking:”. SPR 62400
ICD-10 codes now show in the CPOE A&P-CCC form in the Order Information message. SPR
62750

The Entry-CCC form no longer adds MEL in the chart update. SPR 62866

In the Urgent Care Management form, the drop-down values can now be cleared under the
Reasons Not Performed tab. Data no longer shows in the chart note after the values are
irrelevant. SPR 62751

The Add/Update dialog now allows users to edit the details if there was a validation error in the
data entered. SPR 62845

NDC and CVX are now added to the immunization translation to chart note. SPR 63544

Lot management fields are now cleared after deleting the lots. SPR 62836

The correct Test Management form and editor are now included in the package. SPR 64033

Service Pack 10 Webinar Slides & Recording

ICD-10 Resources & Webinar Series

Editing CCC Text Files for ICD-10

Server Configuration Slides & Recording

See Service Pack 10 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-168309
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Service Pack 11
Features

e Patient Portal data masking This release provides the ability to mask patient data from
displaying on your patient portal in the ambulatory summary CCDA-AS, including lab results,
problems, medications and procedures (orders). This feature is consistent with the
requirements for meeting Meaningful Use View/Download/Transmit objectives. You can mask
data that is confidential or sensitive, data that is required by state law or more appropriate to be
communicated to a patient in person, or any data that might need to be masked for the safety
and well-being of patients. When implemented, this enterprise-wide solution automatically
excludes or includes data you have configured whenever a CCDA is triggered to be sent to the
patient portal. See the release notes for details to implement.

e Transition of Care document enhancements In this release, the Transition of Care (TOC) CCDA
has been shortened and is easier for providers to review and customize.

o TOC document is now encounter-specific, except where CMS requires otherwise, such
as all active medications and problems.

o All chart sections with data that was updated in the encounter are included in the TOC
document and the provider can choose to remove sections that are not relevant for the
transition of care. Create a Transition of Care Document in the Orders module by right-
clicking on an order. On the Preview screen, you can remove an entire section or
customize its content.

o Sections added for customization: Review of Systems, Physical Exam, Advanced
Directives, Family History, History of Past lliness. These sections are included because
they might include information relevant to the transition of care. Providers can
customize the document to exclude these sections if appropriate.

o Displayed data is Visit Specific, Date Based, or Most Recent. While some sections require
display of All Active data (problems, medications), most data are included that were
added in the visit. The latest lab results observations are sent, including historical
observation data. Certain other recent data prior to the clinical date of the parent
document might be included if the provider chooses to include them. For example,
when social history, family history, advanced directives, and functional status
assessments are checked for inclusion, if there is no relevant data from the current visit
then data entered in a previous encounter will be included.

e Export ICD-9 or ICD-10 problem code or both in HL7 messages New LinkLogic export diagnosis
code constraints for problems, procedures, and orders replace previous single option to export
diagnoses with only ICD-9 codes. To configure settings, in Administration, go to System >
LinkLogic > Task Options > Export Tasks and then select the appropriate export task.

e C(linical users can capture NKA and NKDA separately Chart users can now capture No Known
Drug Allergies (NKDA) when an environmental or food allergy is present in the patient chart.
When no allergies are documented, the No Known Allergies (NKA) check box is available. Once a
food or environmental allergy is added, the No Known Drug Allergies (NKDA) check box is
available. SPR 64053
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Cloud-based Advanced Specificity Problem Search Available Cloud-based Advanced Specificity
Problem Search previously in limited availability for testing in SP10 is now available for all
customers. In this release, search methods are enhanced to improve the specificity of results
returned. When this feature is enabled in Administration (in Advanced Features), all providers
(enterprise-wide) using Full Reference Search in Chart or users searching in Billing and Case
Management will access the latest HLI ICD-9 and ICD-10 code data

Server Configurator enhancements Server Configurator was initially released with Service Pack
10, and is used for JBoss and Service Layer installation. Refer to "Automated server
configuration utility" on page 54 for an overview. For detailed instructions, click F1 on the
Configurator to access online help.

o To reduce possible delays and avoid installing unnecessary software on the client, Server
Configurator now checks for enabled admin shares and requires 10 GB free space at the
time the installer selects the drive to install JBOSS to. Previously, it expected all drives to
have admin shares enabled and created GE Deployment directories on all drives when
the Validate & Add button was clicked. SPR 64143

o Server Configurator now alerts you if Windows Power Shell Execution Policy prevents
Server Configurator from installing the Service Layer. When an execution policy is set to
All Signed or Restricted, locate the group policy that has this setting enabled and resolve
it. For additional details, click F1 for Server Configurator online help. SPR 64236

o New options are available for calculating and deploying multiple websites for both full
systems and systems licensed for Centricity PM only.

e Modified Flag and Care Alert performance filter to hide deleted flags This release modified the

Flag and Care Alert performance filter that was implemented in SP10 to reduce the number of

documents, alerts, and flags loaded when the chart is opened. SPR 63149 In the previous release
the filter did not load flags and care alerts with a due date more than 12 months prior to the
current date. In this release the solution is modified to filter out only expired flags, deleted more
than 12 months prior to the current date. Unexpired flags and care alerts are loaded regardless

Fixes

of their due date in accordance with provider view preferences. SPR 64082 See release notes
for details on applying the filter.

Various measure quality reporting fixes
Preferences - Administrator-set Schedule preferences for individual users now persist in the
Administrator’s view after making changes for a user and logging out. Previously,
Administrator’s changes were saved and visible to the user but not for the Administrator. SPR
53757
Problem Search
o Quick Search using Smart List no longer displays problems marked as Inactive (non-
billable). SPR 64471
o Advanced Specificity Search has been modified to return precisely the result a user
selects from the Advanced Specificity Problem Search window. SPR 64113
Advanced Specificity Problem Search - Client no longer crashes when Advanced Specificity
Search is enabled and user adds certain ICD-10 codes to the patient chart. SPR 64553
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Transition of Care (TOC) CCDA

O

Checked/unchecked data items in Transition of Care “Customize Sections & Entries”
sections are now properly included/excluded in the generated CCDA document. SPR
64509

Restored the ability to see latest historical labs in the Lab Results section of the TOC
CCDA per recently finalized 2015 Proposed Rules for Stage 2. SPR 64655

Administration

O

O

Billing
O

CCDA

Customize Letter Window in Administration now includes full view option. Click the
maximize icon in the upper right corner to expand. Click again to minimize. SPR 63964
The Internet URL site type for Advanced Specificity Search cannot be inadvertently
changed in Administration and interrupt the connection. SPR 64140

A user without appropriate permission is not prevented from using Batch Closing
Override. SPR 60778

Corrected an issue causing CCDA validation errors when spaces are included in the
Immunizations section Translation Code attribute value. SPR 59946

CCDA now always includes the manufacturer Organization's standardindustryClassCode.
SPR 62374

Centricity Framework

@)

Chart

When running the Chart module in the Framework, Medication Override Reason list can
now be accessed. SPR 64107

Chart document view no longer randomly resizes to a smaller size. SPR 62420

Drug Override correctly ignores contraindications with food/ethanol when user or
system preferences are set to ignore them regardless of the interaction level, including
when signing clinical list items. SPR 45797

Corrected an issue where after an application error while documenting an office visit,
pending observation terms were SIGNED at the moment of the error, even though the
note remained unsigned. SPR 63017

Patient Banner no longer disappears occasionally when the Enter key is pressed, for
example, after discarding an open document or immediately after selecting a patient's
chart. SPR 63923

Immunization Management form no longer crashes on Save when using the “Preload”
encounter type. Previously, the form crashed if it was the only or first form listed in the
document template associated with the encounter type. SPR 63821

TOC document now linked to master document directly instead of as a child of append.
SPR 64158

Corrected issue that prevented users from double-clicking to open an on-hold Clinical
Visit Summary. SPR 59408

Application allows users without medication override privileges to acknowledge dosing
warnings. SPR 64036

Common Event Model
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o Corrected coding to prevent “Payload is not generated for the Job” errors in JIMX
Console when encountering certain null and empty values. SPR 63095

o Source Of Payments list on Insurance Carrier Information tab now displays the SOP Code
before the Description to facilitate updates required for PQRS reporting. Previously only
the Description displayed. SPR 64108
o Superbill report no longer prints ICD-10 code as ICD-9 code. SPR 62314
o Problem Custom Lists now permit users to edit the ICD-10 code field. See "Edit mapped
ICD-10 code for a problem custom list" on page 9. SPR 63941
o Find Problem workflow for some billable codes no longer returns an ICD-10 diagnosis
SNOMED code link that is a duplicate of the ICD-10 code when the SNOMED code should
be null. SPR 64272
e LinkLogic/ DTS
o DTS Export Hereafter setting now works properly with multiple DTS and starts exporting
changes from the hereafter time value as soon as it is set. SPR 61427
o LinkLogic now provides a way to send only an ICD-10 or ICD-9 code. For details, see
"Export ICD-9 or ICD-10 problem code or both in HL7 messages" on page 6. SPR 63757
e Messaging implementations
o ChartLinx messaging now sends/receives data directly from chart to messaging. The
messaging tab also correctly identifies when unsigned clinical list items are present.
Previously, the Attach Chart window displayed a warning message for presence of
unsigned clinical list items when there were no unsigned items on the patient chart. SPR
63978, 63982, 63823
e Performance
o Addressed a performance issue in archive_obs. Resolution also prevents archive_obs
from being repeatedly exported by DTS. SPR 63363, SPR 62373
o Corrected a coding issue that caused exception in “CMainFrame::OnClose” when user
clicked the X button multiple times on the application main menu page. SPR 64152
o Application no longer crashes when the New Medication window is forced to close
during an Idle Timeout. SPR 64122
o Improved coding to enhance performance and reduce Chart open time. SPR 64123
o Fixed an issue where Lastmodified and Lastmodifedby columns were not updating when
making a change to a patient contact. SPR 63030
o Enhanced DocRoute (route lost documents job) to run more quickly. SPR 64144
o Printing
o Printers specified for a service provider are now honored when tests and referrals are
printed out during an update. SPR 63920
e Problem Search
o Find Problem workflow for some billable codes no longer returns an ICD-10 diagnosis
SNOMED code link that is a duplicate of the ICD-10 code when the SNOMED code should
be null. SPR 64272
o Users can search for any keyword in quick search, using the *Smart List with a
searchable entry in the Most Used Problem list. SPR 64142
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Problem Full Search now stores the SNOMED code needed for Meaningful Use when a

CCDA is generated. SPR 64176
The Internet URL site type for Advanced Specificity Search cannot be inadvertently

changed in Setup and interrupt the connection. SPR 64140

See Service Pack 11 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-177132
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Service Pack 12

Features

Fixes

Data mapping search now includes both start and end range options. New End Date can be set
when searching for observation terms for a specified date range. SPR 63708, SPR 63706

New Active Reports to Activate/Inactivate Codes by Effective and Expiration Date New ICD/CPT
codes are often dispersed in advance of becoming effective with a future effective date. Two
new reports in the Reports > Administrative folder can be used to set to inactive codes that are
not yet effective and to set codes to active when the effective date is met:

O

Inactivate Diagnosis Codes by Date report - This report finds diagnosis codes where your
Input Date is earlier than Effective Date or after or the same as the code’s Expiration
Date. An optional update query will inactivate all codes returned to prevent them from
appearing in problem search results in the Chart module. If you perform optional
inactivation, you must wait 15-20 minutes for problem search SOLR index files to be
fully updated before expecting inactivated codes to disappear from problem search
results.

Activate Diagnosis Codes by Effective Date report - Use this report to find diagnosis
codes where the Input Date you specify is earlier than code Effective Date. An optional
update query will activate all codes returned to make them available to display in
problem search results in the Chart module. If you perform optional activation, you
must wait 15-20 minutes for problem search SOLR index files to be fully updated before
using problem search to retrieve newly activated codes.

Administration

O

Billing
o

Chart
O

Fixed an issue under Orders > Service providers where the list of providers did not scroll
to view the entire list. SPR 63880

Fixed an issue where problem and procedure codes were duplicated in billing. SPR
64699

NG Feeds and G-Tube Feeds can now be selected as routes when adding a medication.
SPR 66685

Fixed an issue where, if an encounter form was set to automatically check “Medication
list reviewed during this update”, the review was not being recorded correctly. SPR
66466

Addressed specific workflows associated with SPR 62043 where, if the patient had
entries in the Provider/User in the FLAGS.TOUSER, FLAGS.FROMUSER, and
PERSON.RESPPROV fields, but the user was missing from the USR table, Null exceptions
on INSURANC.PSISTATE,IMMUNIZATION.SERIES, the application would crash. This
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resulted in the application crashing while attempting to add or modify a medication and
Rx refills. SPR 66601

Fixed and issue where the default print items for printing chart documents was
incorrect. SPR 66239

Fixed an issue where printing a form caused the application to freeze. SPR 66335

Fixed an issue where diagnosis information was not saved correctly when a POA
indicator was included. SPR 66336

Added two scripts and multiple reports to address and issue where document signing
was occasionally not signing all Clinical List items. See "Unsigned Clinical List Reports" on
page 12 for details on the scripts and reports and how to run them. SPR 66205, SPR
66207, SPR 66208, SPR 66211, SPR 66212

Fixed an issue where new encounters were slow to open, especially on large patient
charts. This fix includes an overloading data symbol LIST_OBS, adding a fifth argument
“docDetails”: The syntax is: LIST_OBS(observation,status,list_type,format, [docDetails])
The new argument “docDetails” is a Boolean type and is set to TRUE by default. When
set to FALSE, unnecessary reads to the Document table are eliminated; therefore, the
following data from the Document table will not be returned: Location of Care,
Document Type, Visible Document ID. This argument is used only for the delimited
format. For example: LIST_OBS("MEDS REVIEW", "Signed", "Delimited", "value", FALSE)
Returns: Done”03/14/201672:11:57 PM”Harry S. Winston MD”*Harry S. Winston
MDAAANAAN SPR 65737

Fixed an issue where users were getting an alert “Another user is editing text, try again
later.” SPR 61045

The Immunization and Medication Administration custom list editors now require and
check for a valid NDC code Format. The Immunization custom list editor includes an NDC
Format field on the Edit Vaccine window that allows user to specify the standard NDC
format 5-4-2 or 4-4-3 when entering an 11-character NDC code. Default format is 5-4-2.
The Medication Administration custom list editor specified the format required on the
NDC Code entry field. The system validates the code with the format before saving it to
the database. If the field is blank, you see an “Invalid NDC code” error. If you enter less
than or more than 11 characters or include characters other than hyphens, you see the
message: “Invalid NDC code. Please enter a valid NDC format (e.g. 5-4-2 or 4-4-3).” The
vaccine administration form displays the NDC number in read only format. If you notice
an error during an update, note the correction in the comment field for the
administration. NDC number corrections must be done in the custom list editor. After
upgrade, review your custom lists for incorrectly formatted NDC numbers. SPR 63012,
SPR 63014

Fixed an issue where the “Previous” button was not working properly when navigating
between encounter forms. SPR 65856

Addressed an issue when working in an encounter form and a message opened and was
dismissed, the encounter form was resizing to the default size. SPR 66185

Fixed an issue where loading a new encounter took more time than expected, especially
in large charts. SPR 65738
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Fixed an issue where entering vaccines from the Immunization Management form
encountered a space limitation and did not appear in the chart, and led to a script error.
SPR 61667

Fixed an issue where the Potential Diagnosis list in Update Orders was showing as not
ICD-10 specific, even if they had a valid ICD-10 code. SPR 66163

Fixed an issue where procedure codes built on the Problem Custom List were not visible
when adding new problems. SPR 65669

Fixed an issue where adding an adverse reaction to an immunization created marked
the immunization as “removed” in the Clinical List Changes. This fix relies on an update
to the Immunization Management HTML form that was released in March 2016. Make
sure you have the Immunization Management HTML Form Patch for CCC Basic v1.4
installed. The patch can be downloaded from the Centricity Services web site at:
https://engage.gehealthcare.com/community/en/ cps/clinical-content. SPR 62173
Fixed an issue where data from certain forms were not showing in the chart. SPR 65675
Addressed an issue where, if the application is published and used as a terminal service,
CPS crashed when opening a Phone Note. SPR 63691

Fixed an issue where the Refresh button wasn’t working on CCC forms. SPR 64054
Fixed an issue where the dosing calculator was giving incorrect dosing information for
certain medications for pediatric patients. SPR 64780

Fixed an issue where the ICD-10 code E11.51 was duplicating in the Update Problems
window when the application was refreshed. SPR 65629

Columns in the Chart Desktop now retain their size if the window is closed and
reopened. SPR 52648

Addressed multiple issues with the scrollbar and cursor jumping to the top of the
screen. SPR 63553, SPR 64219, SPR 45236

Fixed an issue where a warning was given when adding problems that a duplicate
problem was being added even though the ICD-10 codes were different. SPR 64042
Fixed an issue where users were unable to select “Additional Signature Required” on a
Custom Document type if the permission had been given and then removed. SPR 64128
Addressed multiple issues where inserting forms into an encounter, the new form did
not get inserted directly below the current form. SPR 64307, SPR 55244

Addressed multiple issues where clicking to go to another form component from the
CCC Basic encounter type opened a different component. SPR 58736, SPR 60368
Addressed multiple issues where old flags were causing the application to crash. SPR
60101, SPR 61330

Fixed an issue to improve signing transaction protection. Clinical data (such as obs
terms, orders, meds, allergies, directives, and the document itself) is not signed if
sighing a document failed. SPR 63017

Fixed an issue where the Immunization Custom List Editor was not pre-populating the
VIS Date for Vaccine Groups. SPR 63549

Fixed an issue where non-strength medications in the reference list were not indicating
drug interactions when prescribed. SPR 63637
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e General

O

O

Fixed an issue when using Real Time Eligibility in Registration, a warning about “EDI
Tracking Enabled” appears across the title of Chart. SPR 58161

Orders that have been sent are no longer marked as unsigned by the Unsigned Clinical
List reports. SPR 66767

The Unsigned Clinical List reports no longer give an error if a the clinical date of a
document is very old. SPR 66769

Fixed an issue where CCDAs were not resent after the Unsigned Clinical List repair script
if the corrupted item was from an HTML form. SPR 66772

The Unsigned Clinical List Auto-Repaired report now shows which problem an
assessment was for. SPR 66773

Fixed performance issues while running the historical repair script after the nightly job.
SPR 66779

Fixed an issue where the local printer was being used for task-based printing rather than
the printer indicated for that task. SPR 66668

Fixed an issue where Dragon crashed when turning on the microphone. If you had
previously changed the settings of the Dragon nsapp.ini file for emrTer from 9to - 1, you
will need to change it back to 9 — see release notes for details

Reverted a fix for SPR 63017 in Service Pack 11 that attempted to improve signing
transaction protection, where clinical data (such as obs terms, orders, medications,
allergies, directives) was signed, but the document was not signed if signing it failed. SPR
65931

Fixed an issue where inactive users were not showing in selection lists, even though
“Show Inactive Items” was checked. SPR 65579

Fixed an issue where only 200 active users were visible when selecting a provider. SPR
65346

¢ Meaningful Use

e MIK

O

Fixed an issue where CareTransln obs values were not being counted correctly in the
denominator for the Medication Reconciliation functional measure. A database repair
script has also been added to ensure that any existing CareTransIn obs values are
counted correctly. SPR 65762, SPR 65921

Fixed an issue where low numerators may have presented for CPOE Laboratory and
Radiology orders in workflows that included non-credentialed and credentialed users
making numerous clinical list changes within a document. SPR 65408

Fixes an issue where documents co-signed after the nightly JSON extract were not
associated with the EP unless they were appended. SPR 63961

Addressed an issue where, if a CPS database is licensed only for PM and not Chart, the
Patient Merge HL7 ADTAA18 message fails to be sent. Previously, an error appeared in
the MIK Event Log: “Send done, status=MIK_ERROR, msg = Cannot find any information
about patientld mapping for the destination LinkLogic.” SPR 63825
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e Orders
O

Fixed an issue where, if a Problem was added to the chart twice from different lists, an
incorrect Diagnosis displayed in Update Orders. SPR 64778

Fixed an issue where the application would freeze intermittently when placing orders.
SPR 65418

Fixed an issue where the ORDER NEW data symbol did not trigger when the document
was signed so the EMR Link Process Order Form did not trigger that the order was
signed. SPR 65375

Fixed an issue where orders did not show on the Orders tab when using a Service
Provider with the NO FORM setting enabled. SPR 65378

Fixed an issue where test order forms printed blank when signing orders at the end of
an update. Orders that have previously been processed incorrectly due to this issue may
reappear in the document; however, they are not duplicates and will not be sent out
again. SPR 65353

Fixed an issue where duplicate order numbers were occasionally generated. SPR 47153
Fixed an issue where the printer designated as the default printer for Orders was not
being used and the printer was defaulting to the printer selected for “All Other
Documents”. SPR 61752

Fixed an issue where orders were printed to the default printer and not the one selected
in “Task Based Printing”. SPR 65281

e Performance

@)

O
O

Performance and stability enhancements. SPR 64310, SPR 64114, SPR 64152, SPR 64744,
SPR 64818, SPR 65495, SPR 61023, SPR 65758

Updated Configurator to better handle setting up smaller systems. SPR 66153

This patch includes performance enhancements that optimize the core stored
procedure (processworkstalog) used when refreshing. SPR 66369

e Prescriptions

O

Fixed an issue where medications were disappearing on the Prescription Refill form
when the MEL symbol MED_LIST_CHANGES(“DELIMITED”) was used in the text
component and Prescriptions form. SPR 57312

e Problem Search

O

Fixed multiple issues where Advanced Problem Search gave errors when searching for
specific problems. SPR 65944, SPR 65945, SPR 65946, SPR 65966, SPR 65362

If you enter a search term mapped as a keyword to a problem code in your most
recently used problems list (Smart List), any codes mapped to that keyword will appear
in search results at the top of the list. For example, if you type the keyword “dm2” and
you have problem AODM in your most recently used problem list, then that code will
appear at the top of the list followed by other problems mapped to diabetes. Problem
codes on the Smart List that match the entered search term either by keyword or
description are listed first. Matches to codes that are not on the Smart List are listed
next (up to list maximum of 20). SPR 64142

When a code has been marked as inactive in the Diagnosis table it is now considered
non-billable and is not be displayed in Smart List search results. SPR 64471
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e Reports
o Updated the Problems Report to include ICD-10 codes. SPR 64168
o Fixed an issue where the Diagnosis search stopped working in reports if the caption of
the “config.xml” file was changed. SPR 62562
e Schedule
o Schedule limits now honored in the Appointment Search with new override options. If
you define daily limits for the day for Appointment Types or Financial Class Limits in the
schedule template for a provider and then search for that type of appointment, only
available slots in days where the daily limit has not been met will display. Previously, all
available slots displayed and you had to select a slot to find out of that day's limit had
been met. With proper security, users may override template restrictions on daily limits
by selecting one of the following options on the appointment search window. These
options are useful when no results are returned for a schedule that contains limits and a
user needs to override the limit restriction: 1. Override search results to return dates
where Appointment Type limits have been met 2. Override search results to return
dates where Financial Class limits have been met SPR 64294
e Settings
o Added the setting “EnableNewSigningTransactScope” to the file mlsetvar.txt to adjust
the scope of signing transactions to address an issue where forms with long document
temp variables (over 4000 characters), gave an application error while documenting an
office visit, and pending observation terms were SIGNED at the moment of the error,
even though the note remained unsigned. Set the variable to TRUE to enable the new
transaction signing scope, or FALSE to turn it off. SPR 64383
e Unsigned Clinical List Reports
o Anissue was detected that document signing is occasionally not signing all Clinical List
items (problems, medications, prescriptions, immunizations, in-office medication
administration, allergies, advanced directives, care plans, observation terms, and
orders). In such cases, these Clinical List items related to a patient chart are not
displayed to the user even though they are saved in the database. SPR 65656 This
package includes five reports to determine if any patient charts were affected by this
issue and a repair script. SPR 66205, SPR 66207, SPR 66208, SPR 66211, SPR 66212
See Release Notes for Details Video

See Service Pack 12 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-214388



https://engage.gehealthcare.com/videos/2074
https://engage.gehealthcare.com/docs/DOC-214388

GE Healthcare

Service Pack 13

Features

e Objective 3 - Recommended workflow for CPOE Entering User Some customers may benefit
from the following modified workflow for the CPOE objective for the remainder of the 2016
reporting year for Meaningful Use.

e  Getting credit for CMS 50 (Closing the referral loop: receipt of specialist report)

e Computed Dose Calculation (CQM 154 and CQM 146) The system now stores the computed
dose calculation with the medication information so that the daily dose and frequency per day
can be reported in the exported CCDA document, and CQR can compute the cumulative
medication dose. Cumulative medication duration is generally calculated as the number of doses
in the interval of interest, divided by the doses per day. For example, if a patient received 60
doses in the interval of interest, and took three doses per day, the CMD would be 20 days (60 / 3
= 20). Previously, the daily dose and frequency per day was not reported in the exported CCDA
document and CQR could not compute the cumulative medication dose. So for 2016 CQR uses
the medication start and end dates, which might represent a higher cumulative dose than the
patient actually received. For 2017 reporting, CMS 154 and CMS146 will be updated to use the
prescription details when available. F1774

e Location of care associated with procedures and reported to CQR CPC Initiative (CPCi) and CPC
Plus Reporting. Clinics participating in the Comprehensive Primary Care Initiative (CPCi) must
report the location of care associated with an encounter or delivery procedure. However, for
SNOMEDCT encounter codes, the order location was not included in the CCDA, so the provider's
location is used. For providers practicing in many locations who do not use CPT encounter
codes, the CQR default location may be inaccurate. Now location of care is associated with
procedures for encounters so you can report the location of care associated with a procedure
when that patient's CCDA is exported to CQR. This ensures that quality measures associated
with procedures are calculated correctly. The generated procedure and location of care meet
requirements under edition certification criteria. F1462

e Objective 9 - Secure Electronic Messaging to 1 patient For 2017 reporting, SureScripts now
records a Secure Message Sent to Patient with event type ID 522 in the MUActivityLog to meet
the new 2016 Secure Electronic Messaging (Objective 9) requirement to count messages sent to
patients. Eligible providers need only send to one patient to meet the measure for 2016.
Historical messages sent are not counted. Centricity Patient Portal, a.k.a. Secure Messaging
Patient Portal (SMPP, Surescripts Portal) v7.0.6 is required for this measure and will be available
before the end of 2016.

e Data mapping support for multiple reporting periods You can now view code mappings from
clinical data to coded values used in quality measures for a specified reporting period. On the
eMeasures Explorer tab under eMeasures, you can select your Reporting Year (2015, 2016, and
2017 for current year 2016) to see measures and value sets and configure mapped values for
that reporting period. Default is the current year. After May 2016, 2015 value sets will not be
included in Knowledgebase updates. In 2016 Q4, 2017 value sets will also be included in
updates. When you select Reporting Year 2015 on the eMeasures Explorer tab, you will not see
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2015 measures and value sets. You will see any custom mappings you have created with 2015
values

e Map an observation term and fixed value to concept code Some measures require result codes
(positive, negative) in addition to the concept code. You can now map an observation term or
observation term and fixed value, to a concept code (such as Hep B Antigen Test) and result
code (such as Positive). On the Data Mapping > Data Search tab, when there is at least one value
set that can be used as a result code, you can select the code to map from the list available on
the Result Code column for the observation. All available values are grouped under the value set
name. The next time a CCDA is sent, it reflects any data resulting from that mapping. This
change helps keep CQR information up-to-date without requiring services intervention to
correct mappings. Patients affected by changed mappings are automatically sent to CQR. See
next section. F1460

e Data mapping changes now exported automatically Patient data changed when data mappings
are modified is now sent automatically to CQR. A nightly job that runs on Friday evening at 8 PM
(MU_NightlyDataFixes- ) included in this update helps ensure new and changed data mappings
can be pushed to CQR (as scheduled) for current and historical reporting. The first time the job is
run, it will identify every patient seen in 2016 with observations in the past 5 years. Any patients
with observations where data mappings were changed since Jan 1, 2016, are resent to CQR via
the quality measure subscription the next time it is scheduled to run. A date value for
lastRunDate is stored in the SYMBOL table. Whenever the job runs, this date is compared to the
LastModified date in the CQM_MAP table, so only the latest changed data for patients is sent.
SPR 66467

e SOP code changes automatically sent to CQR Patient data changed when SOP codes are added
or changed for a patient’s insurance carrier is now sent to CQR automatically. A nightly script
that runs on Friday evening at 8 PM (MU_NightlyDataFixes-) checks for new and changed SOP
codes to be pushed to CQR (as scheduled). The first time the script runs, for every patient who
was seen this year with observations in the past 5 years, any changes/additions to SOP codes
since Jan 1, 2016, are resent to CQR via the quality measure subscription the next time it is
scheduled to process. A date value for InsSOP_db_Updated_Date is stored in the
INSURANCECARRIERS table. Whenever the script runs, this date is checked, so only the latest
changed data for patients is sent. SPR 67634

e Removed mappings are inactivated, not deleted Now when you select a mapped observation on
the Data Mappings > Data Search tab and click Remove, the mapping remains in the CQM_MAP
table but is set to Inactive. It no longer displays in search results or produces output in a CCDA
that includes data managed by the CQM_MAP table. If you choose to add the same mapping
later, the inactive mapping is reactivated. The next time a CCDA is sent, it reflects any data
resulting from that mapping. This change helps keep CQR information up-to-date without
requiring services intervention to correct mappings. F1991

e Change subscription initial date in JMX console A reset Subscription function is now available
under CEMMonitoring in the JMX Console, which effectively deletes a subscription and
recreates it and does not require a JBoss restart. This method can be used when the
subscription initialDate must be changed and data resent for Clinical Quality Measures and
Functional Measures Reporting. This is a more efficient method than deleting and reimporting
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the subscription in Administration. Parameter p1 (subscription name) must contain the name of
the CQR subscription to be reset: either Clinical Quality Measures Reporting or Meaningful Use
Functional Measures Reporting. Parameter p2 (initialDate) specifies the date from which data is
to be re-exported. If initialDate is not specified, it defaults to the value set when the
subscription was created. Resending to CQR begins at the start time configured in the current
subscription. The date must be in the format of YYYY-MM-DD. SPR 62360 SPR 57037 See details
in release notes.

Fixes

Modified order end date calculations for more accurate CQM reporting

Correct completed orders set as Transition of Care in error Click Change for a Completed order
and then check or uncheck Create Transition of Care to correct orders accidentally checked as
Transition of Care. This can happen, for example, when an external provider is replaced with an
internal provider for a referral. SPR 67812

Increased time allowed for JSON extract prevents data omission to CQR

After merging patients, new patient’s data is used in measures

Reduced CCDA ingestion failure

Service Pack 13 Webinar Slides & Recording

See Service Pack 13 Release Notes for Full Details: https://engage.gehealthcare.com/docs/DOC-245335
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Practice Management Only Highlights

e CPS 12 Release:

O

New User Interface Look N Feel with Microsoft-style ribbon and left hand menu
navigation

e Service Pack 3:

O

Problem search in custom lists and quick search now includes results where the term is
contained as a word anywhere in the description as long as it is a word by itself and not
a suffix. For example, a search for “pain” will return results for head pain, stomach pain,
hip pain, etc. It will not return results where “pain” is not a separate word such as
“hippain”. SPR 59266

e Service Pack 4:

O

@)

Race information for “White” and “Native Hawaiian or Other Pacific Islander” were
being removed from the database when upgrading to Centricity Practice Solution 12.
SPR 60190

Upgrading to Centricity Practice Solution 12 was causing Foreign Key constraint errors.
SPR 60212

e Service Pack 5:

O

O

The installer no longer fails with the error “Foreign Key Constraint
‘FK_PatientRace_PID’”. SPR 60034

Opening multiple list views no longer causes application crashes due to “out of
memory” errors. SPR 60331

The client installer now correctly places registry values in the correct registry for 64-bit
operating systems. SPR 60459

Fixed an issue where payment entry gave an error and caused an application crash. SPR
60446

e Service Pack 6:

O
O

Various stability fixes. SPR 60217, SPR 60263, SPR 60552, SPR 60598

When generating a statement for a patient who has a balance under two companies,
statements are generated for both companies. SPR 60568

Fixed an issue where multiple instances of the same patient visit would crash the
application when the visit is saved. SPR 60608

Now able to generate an on Demand Statement for an account that has a credit
balance. SPR 60637

e Service Pack 7

e}

Performance & Reliability Updates

e Service Pack 8

O

Fixes for problem search:
= Results now include descriptions with special characters. SPR 62434/54197
=  The quick search function now displays up to 10 results. SPR 62446
= The smart search filter now returns results if the keyword(s) phrase is longer
than 15 characters. SPR 62435/52881
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Service Pack 9

O

= |CD search now includes full synonym search capability. The next ICD and CPT
updates after January 2015 must be installed. SPR 62455/54247

Improved application stability when a network or server error is encountered. SPR
62694/SPR 61410

Fixed an issue where patients were randomly left off a statement run when batching
them from Reports > File > Statements. SPR 62849/SPR 61659

Service Pack 10

O

Multiple updates for ICD-10, see service pack 10 release notes and ICD-10 community
for details

Build and manage Task queues with Diagnoses as a criteria In Task Management >
Queue Administration > Build Queues, the Queue Criteria pane allows users to search
for and add one or more diagnoses to associate with the visit using the Find Diagnosis
window. The application also alerts you when you have entered an invalid code.
Interoperability - MIK can determine the correct ICD code when duplicate code names
exist in ICD 9 and ICD 10. When problem codes are received from an external system
without a coding system name value, sometimes a unique match cannot be found based
on the code value alone if the code value exists in both ICD9 and ICD10 code databases.
When this happens, MIK sends “???” for the code to the Notes tab and notes that “MIK
import found multiple codes matching the diagnosis ...."”. To prevent these unmatched
codes, MIK now matches using both the code value and the code system name. The
coding system database to search is set to ICD9 by default in MIK Destination setup.
Important. When your organization implements ICD10, change this setting to ICD10. SPR
63443

Automated server configuration utility The Server Configurator calculates, installs and
deploys the recommended JBoss and Service Layer configuration for your site. You can
add/remove servers to meet the recommended configuration, validate, and then
automatically install JBoss to support the selected configuration. The Apply Updates,
Install JBoss, Install Service Layer, Install Website, and Change App Logon buttons have
been removed from Server Setup. You must use Server Configurator for these tasks.
Server Configurator is launched after you have installed or updated your database with
Server Setup. The Server Configurator button is located on the main Server Setup menu.
Press F1 after launching Server Configurator to access the online help. See Release
Notes for more details.

Performance and stability enhancements. SPR 61049, SPR 61385, SPR 61797, SPR 61923,
SPR 63166, SPR 63333, SPR 63349, SPR 63374, SPR 63412, SPR 63434, SPR 63438, SPR
63441, SPR 63466, SPR 63470, SPR 63474, SPR 63572, SPR 63655, SPR 63816, SPR 63696
Addresses various login issues. SPR 60959, SPR 60996, SPR 61011, SPR 61026, SPR
61027, SPR 61028, SPR 61044

Addresses an issue where bulk retrieving charges procedure codes were randomly
duplicated multiple times for each charge on the visit. SPR 62595

Addresses an issue where the scrollbar suddenly jumps to the top of the window during
a refresh. SPR 62933
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Diagnosis codes are now saved correctly to the visit. SPR 62977

Quick and full problem search results that are an exact match for text entered now
appear at the top of the list of returned results. SPR 63967

Corrected some keywords data content for problem search with incorrect associations.
SPR 63808

Advanced Specificity Problem Search attribute filtering now functioning properly and
returning all appropriate codes. Previously, clinical concepts that require a circumstance
code in addition to a primary diagnosis could not be refined to select the circumstance
code. SPR 64002

Addresses performance and stability issues occurring at sites running more than 3
website/JBoss deployments. Now on Server Configurator you can choose configuration
settings options for 2-4 or 5-8 web site deployments. See “ICD-10 planning and
preparation resources on the Service Portal” on page 10. SPR 63974

Service Pack 11

O

Cloud-based Advanced Specificity Problem Search Available Cloud-based Advanced
Specificity Problem Search previously in limited availability for testing in SP10 is now
available for all customers. In this release, search methods are enhanced to improve the
specificity of results returned. When this feature is enabled in Administration (in
Advanced Features), all providers (enterprise-wide) using Full Reference Search in Chart
or users searching in Billing and Case Management will access the latest HLI ICD-9 and
ICD-10 code data
Server Configurator enhancements Server Configurator was initially released with
Service Pack 10, and is used for JBoss and Service Layer installation. Refer to
"Automated server configuration utility" on page 54 for an overview. For detailed
instructions, click F1 on the Configurator to access online help.
= To reduce possible delays and avoid installing unnecessary software on the
client, Server Configurator now checks for enabled admin shares and requires
10 GB free space at the time the installer selects the drive to install JBOSS to.
Previously, it expected all drives to have admin shares enabled and created GE
Deployment directories on all drives when the Validate & Add button was
clicked. SPR 64143
=  Server Configurator now alerts you if Windows Power Shell Execution Policy
prevents Server Configurator from installing the Service Layer. When an
execution policy is set to All Signed or Restricted, locate the group policy that
has this setting enabled and resolve it. For additional details, click F1 for Server
Configurator online help. SPR 64236
= New options are available for calculating and deploying multiple websites for
both full systems and systems licensed for Centricity PM only.
Preferences - Administrator-set Schedule preferences for individual users now persist in
the Administrator’s view after making changes for a user and logging out. Previously,
Administrator’s changes were saved and visible to the user but not for the
Administrator. SPR 53757
Problem Search
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=  Quick Search using Smart List no longer displays problems marked as Inactive
(non-billable). SPR 64471
= Advanced Specificity Search has been modified to return precisely the result a
user selects from the Advanced Specificity Problem Search window. SPR 64113
Advanced Specificity Problem Search - Client no longer crashes when Advanced
Specificity Search is enabled and user adds certain ICD-10 codes to the patient chart.
SPR 64553
A user without appropriate permission is not prevented from using Batch Closing
Override. SPR 60778
Source Of Payments list on Insurance Carrier Information tab now displays the SOP Code
before the Description to facilitate updates required for PQRS reporting. Previously only
the Description displayed. SPR 64108
Superbill report no longer prints ICD-10 code as ICD-9 code. SPR 62314
Problem Custom Lists now permit users to edit the ICD-10 code field. See "Edit mapped
ICD-10 code for a problem custom list" on page 9. SPR 63941
Find Problem workflow for some billable codes no longer returns an ICD-10 diagnosis
SNOMED code link that is a duplicate of the ICD-10 code when the SNOMED code should
be null. SPR 64272

Service Pack 12

O

New Active Reports to Activate/Inactivate Codes by Effective and Expiration Date New

ICD/CPT codes are often dispersed in advance of becoming effective with a future

effective date. Two new reports in the Reports > Administrative folder can be used to

set to inactive codes that are not yet effective and to set codes to active when the

effective date is met:

= |nactivate Diagnosis Codes by Date report - This report finds diagnosis codes
where your Input Date is earlier than Effective Date or after or the same as the
code’s Expiration Date. An optional update query will inactivate all codes
returned to prevent them from appearing in problem search results in the Chart
module. If you perform optional inactivation, you must wait 15-20 minutes for
problem search SOLR index files to be fully updated before expecting
inactivated codes to disappear from problem search results.
= Activate Diagnosis Codes by Effective Date report - Use this report to find

diagnosis codes where the Input Date you specify is earlier than code Effective
Date. An optional update query will activate all codes returned to make them
available to display in problem search results in the Chart module. If you
perform optional activation, you must wait 15-20 minutes for problem search
SOLR index files to be fully updated before using problem search to retrieve
newly activated codes.

Fixed an issue where problem and procedure codes were duplicated in billing. SPR

64699

Fixed an issue when using Real Time Eligibility in Registration, a warning about “EDI

Tracking Enabled” appears across the title of Chart. SPR 58161
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Addressed an issue where, if a CPS database is licensed only for PM and not Chart, the
Patient Merge HL7 ADT*A18 message fails to be sent. Previously, an error appeared in
the MIK Event Log: “Send done, status=MIK_ERROR, msg = Cannot find any information
about patientld mapping for the destination LinkLogic.” SPR 63825

Performance and stability enhancements. SPR 64310, SPR 64114, SPR 64152, SPR 64744,
SPR 64818, SPR 65495, SPR 61023, SPR 65758

Updated Configurator to better handle setting up smaller systems. SPR 66153

This patch includes performance enhancements that optimize the core stored
procedure (processworkstalog) used when refreshing. SPR 66369

Schedule limits now honored in the Appointment Search with new override options. If
you define daily limits for the day for Appointment Types or Financial Class Limits in the
schedule template for a provider and then search for that type of appointment, only
available slots in days where the daily limit has not been met will display. Previously, all
available slots displayed and you had to select a slot to find out of that day's limit had
been met. With proper security, users may override template restrictions on daily limits
by selecting one of the following options on the appointment search window. These
options are useful when no results are returned for a schedule that contains limits and a
user needs to override the limit restriction: 1. Override search results to return dates
where Appointment Type limits have been met 2. Override search results to return
dates where Financial Class limits have been met SPR 64294

Service Pack 13

O

None



